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Welcome to NPR Digital Services Streaming Services 
 
Please email us at help@ds.npr.org to let us know that you have received your streaming encoder.  
 
NPR Digital Services provides a competitive best of breed streaming audio solution. The station 
receives: 
 

 24/7 online stream of your terrestrial broadcast in MP3 or Windows Media format. 

 Unlimited simultaneous audio streams to your listeners. 

 All hardware and software needed to stream (encoding computer, encoding software, 
etc.). 

 Industry standard media player with station brand and station-branded web space. 

 24/7 technical support and encoder maintenance. 

 We provide access to detailed online reports via http://control.llnw.com Contact us for 
your log in information. 

 

Setting up your Live Audio Stream  
 
This encoder (i.e. computer) will encode your station’s live air signal for streaming via the web.  
 
Your encoder has been preconfigured for your network. The encoder comes with current Windows 
OS and appropriate encoding software to encode your signal. The encoder is specifically configured 
to encode your live stream. 
 
The following steps will help you set up your encoder and start streaming your signal. The enclosed 
support documents will help answer many of your questions regarding streaming. 
 

Encoder Packing List: 
 
Hardware: 

 SuperMicro – Super Server 

 Sound Card 

Software: 

 Windows 2000 or XP 

 Encoding software 
(preconfigured) 

 LogMeIn remote access 
software 

 
Resources: 
Streaming Information and FAQs 
http://digitalservices.npr.org/affstreaming.html  
 
Streaming section of the blog:  
http://blog.digitalservices.npr.org/category/streaming/  

 

 
 

How It Works 
 

1. Analog audio (your signal) is fed into the encoding computer’s sound card. 
 

2. The encoding software encodes the analog audio and delivers it to an entry server in digital 
format, via the Internet. It is the station’s responsibility to deliver their stream to an entry 
server. 
 

mailto:help@ds.npr.org
http://control.llnw.com/
http://www.publicinteractive.com/affstreaming.html
http://blog.digitalservices.npr.org/category/streaming/
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3. Our streaming provider will replicate your stream as needed, and stream your signal from 
their global network of streaming servers.  
 

4. The stream travels from the optimal streaming server to the listener via the Internet. Our 
streaming provider uses intelligent routing and load balancing to get the stream to the user as 
quickly as possible.  
 

5. Listeners receive audio stream via your web site.  
 
 

Encoder Set Up 
 
1. Unpack the encoder and check that you have all the parts listed on page one.  
 
2. Proceed to where the encoder will be installed. Make sure the live audio signal has been run to 
the same location. Set up the encoding computer (monitor, keyboard, mouse) and connect it to your 
local network. 
 

 Turn on the encoder. The encoding software will automatically start up. 

 Make sure it has internet access. An easy way to check is to start up Internet Explorer. 

 Plug your audio source line into the back of the encoder. Recommended level is 
around –10 Dv. NOTE: Plug the audio source into the line-in jack (blue). (1/8

th
 headphone 

jack)  

 Balanced cables recommended. 

 Reminder: The encoder remains property of NPR Digital Services. Do not change encoding 
software settings, install additional software on this machine, etc. without permission from 
NPR Digital Services. If you do, the station will be responsible for additional costs incurred 
(including labor and hardware) in fixing any problems that may arise as a result. 
 

3. Update your Firewall settings: Please configure your firewall to allow traffic both in and out from 
the streaming encoder.  
 

 Please allow access for the following IPs thru port 8080 
69.28.136.80 
69.28.136.81 
69.28.136.82 
 

 Please also allow access for the following networks thru port 8080: 
69.28.128.0/18  
68.142.64.0/18  
208.111.128.0/18  

 
4. Contact NPR Digital Services at help@ds.npr.org. Make sure the encoder is on and sending out 
a stream. Once we establish that we have remote access to the encoder, you’re done! We’ll take it 
from here! NPR Digital Services will access the encoder remotely and continue the set up process. 
Typically this takes two-three business days. 
 

 Mono vs. stereo: At rates under 64 kbps, we recommend that stations stream in mono rather 
than stereo. At 24kbps, mono delivers a higher definition stream than stereo, and listeners 
will not receive the stereo separation cues. For reference, to stream at near CD quality, you'd 
have to stream at 128kbps. To receive stereo separation cues, 64kbps. 

 Encoder Usage: The purpose of this machine is to encode your streaming signal only. 
Please do not install additional software on this machine or change settings without 
permission from NPR Digital Services. Even simple things can compromise streaming 
reliability and our ability to provide support. 

mailto:help@ds.npr.org
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 Anti Virus/Spyware software: We don't ship our encoders with any software of that nature 
installed. We have had multiple reports of various AV products interfering with audio 
streaming quality and connectivity. 

 Windows Updates: We recommend that encoders are configured to download Windows 
software updates for security purposes, but not automatically installed, as this can often lead 
to unplanned and poorly timed streaming outages due to automatic computer restarts being 
initiated after updates are installed. 

 
5. Stream is submitted to our streaming provider: Within two business days, your stream will be 
captured and put online. You will receive a test URL, then QA will begin. 
 
6. QA: We’ll monitor your stream for one to three days to verify the connection and configuration. 
 
7. Update Web Space: After QA, your station's stream will be published into your streaming web 
space http://www.publicbroadcasting.net/xxxx/ppr/index.shtml (substitute your call letters). Add a 
link from your home page and add Listen Live links to your site-wide navigation. Stations can also 
design and host their own streaming pages, as long as you link to the asx, pls and m3u files hosted 
on our servers.  
 

 
Usage Rights 
 
Live streaming is available to station affiliates of NPR Digital Services. By electing to carry this 
offering, the affiliate agrees to the terms contained in the NPR Digital Services Client Agreement.  
 
Equipment and software is provided by NPR Digital Services for the sole purpose of streaming 
affiliate’s broadcast signal and is the property of NPR Digital Services.  
 
Usage of this equipment for other purposes is prohibited.  
 
NPR Digital Services must have remote access to the encoder.  
 
Station will use reasonable commercial efforts to safeguard any NPR Digital Services property in their 
possession, and return such equipment on request. 
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Audio Gateways 
 
See also: http://digitalservices.npr.org/streamgateway.html 
 
One of NPR Digital Services's goals is to help our clients improve their membership and revenue 
generating capabilities. Audio gateway announcements precede your live stream and, for example, 
could identify the station, educate listeners about the costs of streaming, or provide a call to action to 
become a member.  
 

Sponsor/Underwriter Gateway 
A number of stations are selling underwriting or sponsorships to help support their streams. 
Underwriting gateways are subject to the same conditions as terrestrial underwriting spots. 

 
Create your own audio gateway 
We recommend that you script and record your own audio gateway. Underwriting gateways are 
subject to the same conditions as terrestrial underwriting spots.  
 

 Length: Must be a minimum of 8 seconds long. We suggest that you keep them under 16 
seconds. As your online listeners will hear them many times, shorter is often better.  

 Personalize the gateway: Use your call letters, familiar voices, your tone, and familiar music 
when creating your gateway.  

 Electronic Format:  
o For Mp3 streams, mp3 format file 
o For Windows media steams: asf (note, if you have .wma file, you can manually 

change the extension to .asf) 
o Sound Quality: We strongly recommend encoding the gateway files at the 

same bitrate as your live stream. If you're not sure, encode at 64kbps. 

 FTP file into JukeBox, using an FTP program such as Filezilla or CuteFTP. Enter FTP 
Host/Server name: ftp://ftp.publicbroadcasting.net and enter the same username and 
password you use to access the Admin Tools. 

 Add Metadata: After you've FTP'd the file, log on to your JukeBox admin toolset: 
http://www.publicbroadcasting.net/xxxx/ondemand.ondemandadmin and click "Add 
Metadata”. You should see the files you just uploaded.  

 Next: Go to "Manage All Media" and click 'File Link". A window with a URL and media ID will 
appear.  

 Send us the full link: Email us the file link at support and we will place the gateway, 
generally within 48 hours.  

 NOTE: Certainly players and apps don’t support or don’t handle gateways well. Most notably, 
iTunes does not currently support streaming gateways. The gateway will play, and then 
another file will play, rarely the live stram. For stations that use gateways, we provide an 
alternative link on your streaming page that does not include the gateway file. When entering 
your stream into Station Connect, please use the url ending in .m3u. 

 

http://www.publicinteractive.com/streamgateway.html
http://www.publicinteractive.com/support.html
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Station Tech Support 
 
NPR Digital Services provides business hours support for all issues, and emergency support 24/7 for 
urgent issues. NPR Digital Services support includes: 
 

 24/7 support of streams from the station streaming server to our streaming provider entry 
point. 

 Same business day support for streams before the entry point, from the station encoder to 
the entry point. 

 Encoder support and replacement. 

 To provide support, we must have remote access to the streaming encoder.  

 Please note: We do not provide end listener support.  
 

What should you do if you think your web stream is down or offline? 

1. Make sure your encoder is on. I know, I know, this seems basic, but we have run into more 
than one instance in which they have been accidentally unplugged or lost power. It’s a little 
embarrassing for everyone. 

2. Make sure your encoder is receiving an audio feed.  It has happened. Again, see above. 
3. Please verify that the stream is offline. Try to listen from more than one computer, location 

or device. If you can hear it from one, but not another, then the stream is online, and the 
problems lie elsewhere. Check with your local IT support or internet provider. 

4. Are you hearing just the gateway/intro, but not the stream? If so, read more about that 
here. 

5. Always try rebooting (restarting) the streaming encoding computer first. This solves many 
problems. 

6. Also make sure you can access the general internet (e.g., can you access google.com) from 
the encoder.  If not, then your internet connection might be offline, or it could be a local 
networking issue. Try your local IT support. 

7. If you’re comfortable, look at the encoder and make sure the Output Tab in WinAmp is 
selected. 

8. Then, if that doesn’t do it, write to us at help@ds.npr.org and we’ll take a look. 
9. Please also make sure we can access the streaming encoder via LogMeIn. 

NON-EMERGENCY STREAMING ISSUES: STATIONS  
For example, if a few listeners are having difficulties connecting to your stream but others can 
connect, or if you're receiving a poor quality stream. NOTE: We do not provide individual end user 
desktop support.  
 

 All times: Station staff should email help@ds.npr.org or complete this form 
http://digitalservices.npr.org/support.html with a brief message, including a reply phone 
number and email address. We will assist you as soon as possible. 

 NOTE: Rebooting (restarting) the encoding computer solves most problems. 
 

STREAMING EMERGENCY: STATIONS 
Help, my stream is offline! This means 

 Three or more people can't connect to your stream 

 You've tried to connect from more than one machine 

 You have heard from multiple listeners that your stream is offline 

 You are sure your internet connection for the encoder is up and running. 

 NOTE: Please restart your encoder. That solves many issues! 
 

 Business hours (9AM-6PM EST): Email help@ds.npr.org or complete this form 
http://digitalservices.npr.org/support.html with a detailed message, including a reply phone 

http://blog.digitalservices.npr.org/2010/10/28/streaming-audio-gateways/
http://blog.digitalservices.npr.org/2010/10/28/streaming-audio-gateways/
http://blog.digitalservices.npr.org/category/streaming/
http://blog.digitalservices.npr.org/category/streaming/
mailto:help@ds.npr.org
http://blog.publicinteractive.com/2011/01/19/streaming-encoder-access-logmein/
mailto:help@ds.npr.org
http://www.publicinteractive.com/support.html
mailto:help@ds.npr.org
http://www.publicinteractive.com/support.html
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number or email address. We will assist you as soon as possible.  
 

 Non-business hours: For emergency technical support (must meet the criteria) outside of 
normal business hours, please see this page for procedure: 
http://digitalservices.npr.org/support.html. PLEASE be available to respond. 
 

 NOTE: Rebooting (restarting) the encoding computer solves most problems. 

 Also refer to this page for tips: http://blog.digitalservices.npr.org/2011/01/26/streaming-
support-tip/    

 
 

http://www.publicinteractive.com/support.html
http://blog.digitalservices.npr.org/2011/01/26/streaming-support-tip/
http://blog.digitalservices.npr.org/2011/01/26/streaming-support-tip/
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Listener Support 
 
Streaming technology is complex and technical support can be time consuming. To help stations, we 
provide an online help section, help sheets for station staff and links to helpful resources. We do not 
provide end listener support. 
 
Please try to respond to the technical questions you receive or direct listeners to the online help 
section. Given the wide scope of possible problems and solutions and given the volume of our 
station’s listeners, we cannot provide listener support, but if you notice a trend, please let us know 
and we’ll do what we can.  

 
MP3 Stream Help 
 
MP3 streams can be played using ITunes, QuickTime™, RealAudio™, Windows Media™ Player, 
Winamp and other media players. Our MP3 streams are available in two different link styles -- .pls 
and .m3u – to accommodate the different player preferences. 

 .m3u: Real Player, Windows Media Player, WinAmp 

 .pls: ITunes, QuickTime, Real Player, WinAmp 
 
ITunes (Mac OS):  

 Use the .pls link to listen to the stream. 

 For additional assistance, please refer to the support section of http://www.apple.com/itunes/ 
or choose the help menu in your iTunes player. 
 

QuickTime (Windows or Mac OS):  

 Use the .pls link to listen to the stream. 

 If the QuickTime player is installed and you have trouble listening to the stream, you may 
need to reinstall or upgrade your QuickTime Player. Certain browsers require the QuickTime 
Plugin, and reinstalling the player will install the necessary plugin. 

 For additional assistance, please refer to the support section of  
http://www.apple.com/quicktime/products/qt/ or choose the help menu in your QuickTime 
Player. 

 
Real Player Basic/RealOne (Windows or Mac OS): 

 Use either the .pls link or .m3u link to listen to the stream. 

 If the Real Player Basic/RealOne player is installed and the link will not play, you may need to 
reset the player’s preferences. Go to the Tools menu -> Preferences. In the left menu, go to 
Content -> Media Types and check off MP3 Audio and MP3 Playlist. Click OK to save the 
settings, then close and restart the player. 

 If you continue to have trouble listening to the stream, consider reinstalling or upgrading your 
Real Player. 

 For additional assistance, please refer to the player support section at 
http://www.expressresponse.com/cgi-
bin/real_rec/new_showFaq.cgi?template=sos.html&errorid=&hurlid=&UC=&producttype=real
one or choose the help menu in your Real Player. 

 
Windows Media Player (WMP):  

 Use the .m3u link to listen to the stream. 

 If Windows Media Player is installed but the stream will not play, you may need to reset the 
player’s preferences. Go into Tools -> Options/Preferences -> Formats and make sure MP3 
is checked off, click Apply, and then close and restart your player.  

 For WMP version 8 and higher, the path for resetting preferences is slightly different. Go to 
the Tools -> Options -> File Types and make sure MP3 is checked off. Save, then close and 
restart your player.  

http://www.apple.com/itunes/
http://real.com/
http://real.com/
http://www.expressresponse.com/cgi-bin/real_rec/new_showFaq.cgi?template=sos.html&errorid=&hurlid=&UC=&producttype=realone
http://www.expressresponse.com/cgi-bin/real_rec/new_showFaq.cgi?template=sos.html&errorid=&hurlid=&UC=&producttype=realone
http://www.expressresponse.com/cgi-bin/real_rec/new_showFaq.cgi?template=sos.html&errorid=&hurlid=&UC=&producttype=realone
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 If you continue to have trouble listening the stream, consider reinstalling or upgrading your 
Windows Media Player.  

 For additional assistance, please visit the Microsoft Windows Media Support Site at: 
http://support.microsoft.com/default.aspx?scid=%2Fsupport%2Fmediaplayer%2Fwmp7%2Ea
sp or choose the help menu in your Windows Media Player. 

 
Windows Media Player all versions (Mac OS): 

 Install Real Player, ITunes, or QuickTime player for the Mac.  

 For additional assistance, please visit the Microsoft Windows Media Support Site at: 
http://www.microsoft.com/windows/windowsmedia/download/mac71.aspx 

 
Winamp:  

 Use the .m3u or .pls link to listen to the stream. 

 For additional assistance, please see the Winamp support section at: 
http://www.winamp.com/download/faq/ or choose the help menu in your Winamp Player. 

 
Additional MP3 Player Options:  
Many additional MP3 players exist, including:  

 
 For Windows 95 and up: WinAmp, MusicMatch, Xaudio, freeAMP or the Microsoft Media 

Player (included in Windows).  

 For Macintosh: iTunes, MacAmp or MacAmp Lite.  

 For Linux, FreeBSD, SunOS and other Unix: Xaudio or mpg123, among others. 
  
This list is not complete! Many players exist, so you have the option to use any player you prefer; 
however, because there are so many options, we are not able to test them all. If your preferred player 
doesn't work, we suggest you do a Google search or install a different player. 
 
Launching the Stream in a Different Media Player 
When you install a media player, you will often see pop-up windows asking you to make this player 
your "default player" (which simply means the player "claims" certain media types and will 
automatically launch in the future when music or videos of those types are played).  
 
Typically, the most recently installed media player will be the default player on your computer for most 
media types unless you set it up NOT to be. You can reset these preferences in the following places:  

 RealPlayer – View -> Preferences -> Upgrade -> Media Types  

 Winamp – Options -> Preferences 

 Windows Media Player – Tools -> Options -> Formats 
 
Firewalls and MP3 Streams 
Strict firewalls may block access to an MP3 stream. Some firewalls are configured to deny any 
inbound traffic not sent on port 80 (the port used by most web traffic). Our MP3 streams are sent out 
on varying ports. If a firewall denies inbound traffic from ports other than 80, contact the network 
administrator and find out if there is a workaround. 

 
 
Windows Media Player Help 
 
Can't Connect 
Many types of interruptions between your computer, your player, your computer’s OS, your local 
network, your ISP and the NPR Digital Services streaming server can exist and cause trouble. Often 
the interruption is temporary. Please try to connect a few times at different times of the day, if 
possible. 
 
Still Can’t Connect 

http://www.microsoft.com/windows/windowsmedia/download/mac71.aspx
http://www.winamp.com/download/faq/
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If you continue to have trouble listening to the stream, consider reinstalling or upgrading your 
Windows Media Player. 
 
Are there Windows Media Player choices for Linux? 
You can use MPlayer, which is free, or The CrossOver Plugin from CodeWeavers for $25. 
 
Saving Programs and Saving/Bookmarking the Stream 
This is a live web stream, so you cannot save specific songs or programs (which is also illegal), but 
you can bookmark the stream in your player. To add the stream to your list of favorites, go to File -> 
Add To Media Library. 
 
Windows Media Error Codes 
The Microsoft Windows Media Support site lists error codes, what they mean and what to do when 
they occur at: 
http://support.microsoft.com/default.aspx?scid=/support/mediaplayer/wmper/wmperrcode_main.asp 
 
Windows Media Support Site 
For additional assistance, please visit the Microsoft Windows Media Support Site at: 
http://support.microsoft.com/default.aspx?scid=%2Fsupport%2Fmediaplayer%2Fwmp7%2Easp or 
choose the help menu in your Windows Media player. 

http://support.microsoft.com/default.aspx?scid=/support/mediaplayer/wmper/wmperrcode_main.asp
http://support.microsoft.com/default.aspx?scid=%2Fsupport%2Fmediaplayer%2Fwmp7%2Easp
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General Stream Help  
 
NOTE: Installing the latest player software solves most online audio or video problems. 

 
Can't Connect 
Many types of interruptions between your computer, your player, your computer’s OS, your local 
network, your ISP and the NPR Digital Services streaming server can exist and cause trouble. Often 
the interruption is temporary. Please try to connect a few times at different times of the day, if 
possible. 
 
Still Can’t Connect 
If you continue to have trouble listening to the stream, consider reinstalling or upgrading your player. 
Installing the latest player software solves most online audio or video problems. 
 
The stream seems to be playing, but I can’t hear anything. 
Due to national program restrictions, SoundExchange licensing requirements and other factors, 
stations may not have rights to stream all the content that they have the rights to air. Also, double-
check the volume settings on your computer. 
 
When I listen to the live stream, the sound skips, cuts out or buffers.  

 If the player doesn't have enough network bandwidth, it will buffer. 

 Solutions: Try increasing your player’s buffering setting, closing other applications and/or 
rebooting your computer. Or try the stream again later, during off peak times.  

 Slow connection: You may not have a fast enough Internet connection to reliably listen to 
audio online. The stream is configured so that an audience member with a 28.8 kbps modem 
can listen, but for best results, we recommend a higher connection speed, at least 56 kbps. 

 Slow computer: If your computer is old, it might be too slow to play the stream regardless of 
what else it’s doing. Or, if you have lots of other programs open, they may be using too much 
processor time and/or RAM for the player to work properly.  

 Internet congestion can slow down the delivery of the stream, make it difficult for you to 
connect or cause buffering. We suggest you keep trying or try again later. If you repeatedly 
have difficulty connecting, please notify your ISP -- there are often quick fixes they can make 
when they learn about your issue.  

 Local congestion: local bandwidth (on your computer or local network) is shared between all 
open applications and the player. Closing applications may reduce buffering. To see what 
proportion of your available bandwidth you're using, right-click on the Microsoft Windows 
Media Player status bar and view statistics.  

 
Why does the stream stop playing after a certain amount of time? 
The stream can be set up to stop after a certain amount of time because our station pays for the 
amount of audio streamed each month. Users who log onto the stream and leave their computers for 
extended periods of time increase our costs. We apologize for the inconvenience and appreciate your 
help in controlling our costs.  

 
I recently upgraded my browser and now the stream won’t play. What can I do? 
In most cases, the player needs browser plug-ins installed in order to work correctly. If you upgrade 
your browser or switch browsers, the live stream may stop working. Re-install the appropriate player 
software using your new browser. 
 
Why does the online live stream sound 'tinny' or like I'm listening in a tunnel? 
Sound files are too large to deliver through Internet dial-up modems without compressing them first. 
We have compressed our web stream to 1/20 of its size, which allows users with a 28.8k dial-up 
modem to listen and helps manage costs; the flip side is the sound quality suffers. 
 


